
Word Processing Basics I—EAS205 
 

When you open Microsoft Word (in Windows XP), you will see a screen that looks like 
this: 
 

 
 
At the top, where you see “File Edit View Insert Format Tools Table Window Help” 
 
These are called “pull down menus” because when you click on them a larger menu will 
appear.  Below the pull down menu bar is a “toolbar” which indicates the font and other 
formatting. 
 
This handout will NOT tell you how to use all Word functions.  Rather, it will lead you 
through the functions you need for Homework #1.  For more complete notes, please see 
the ITS training website at http://web.albany.edu/its/training/modinfo.asp?modreq=D.  
They have downloadable notes for their courses.  Also, please note that their courses are 
NOW AVAILABLE TO STUDENTS, NOT JUST FACULTY AND STAFF. 
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Centering and Enlarging Text 
 
Once you have opened a new file, you can begin typing.  Most machines are set up so 
that “Times New Roman” is the default font and 12 pt. is the default font size.  Note that 
both of these will be indicated on the toolbar at the top of the screen.  (If you need to 
change the font, click on the arrow to the right of the font box to see your choices.) 
 
Begin by typing your title: 
 

 
 
Now you need to do two things: 

1) Center the text 
2) Make the font bigger 

 
To do both, first highlight all of the text (this is most easily done using the mouse).  
When you highlight, the highlighted text will appear in the negative, like this: 
 
The Development of the Japanese Written Language 
 
Once you have done this, click on the “center text” toolbar and the text should move to a 
center position (see diagram on next page). 
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Once you’ve done this, the title should still be highlighted.  Now click on the font size 
box and choose a bigger font—16 or 18 are usually best for a title. 
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Now that you’ve done all this, you’ll have to “undo” it for the body of your paper.  Hit 
return a couple times.  Your cursor will still be in the middle of the screen.  Now, go back 
to the toolbar and click on the left alignment button (to the left of the center alignment 
button you just clicked to center the text).  Likewise, change the font size to 12 pt.  now 
your screen should look like this:  
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Congratulations!  Now you’re ready to type the body of your paper.  You’ll need to 
double space the body.  Here’s how to do that: 
 
Choose the “Format” pull down menu, and under that choose “Paragraph.”  Your screen 
should look something like this: 
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You’ll get a new window that covers many formatting issues.  For the moment, you are 
only interested in spacing.  Most computers are set up so that single spacing is the default.  
You’ll need to change this to double spacing.  Your screen should look like this: 

 6



 
 
Click on “double” and then “OK”.  You’ll return to your document and you’ll be ready to 
type.  When you indent your paragraph, use the Tab key, don’t type a bunch of spaces.  
Word then recognizes what you’re doing is a paragraph, and when you get into fancier 
formatting this is really important.  Also, most fonts are not fixed width, so typing spaces 
does not guarantee the proper alignment. 
 
OK, type two pages of text, being sure that it has the characteristics you’ll need for this 
assignment (see Homework #1 and Homework #2 handouts).  Once you’ve done that, 
return to this point. 
 
Many of the aspects of a manuscript can be put in either while you are typing or after the 
fact.  These instructions will tell you how to do this after the fact not because this is 
inherently better but rather because it’s easier for the purposes of making this handout.  
Feel free to choose either method when you’re writing your own paper.
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Adding Page Numbers 
 

You can add page numbers to your text automatically—they will move if necessary 
without you having to pay attention to them.  You can choose their position (top, bottom, 
right, left) you can choose their style (Arabic or Roman numerals, upper case or lower 
case, etc.), you can choose their font…the choices are wide and varied.  Once your papers 
get big and complicated (i.e., they have prefaces and introductions and they are hundreds 
of pages long) there are some formatting concerns to pay attention to.  Right now, all you 
need to do is learn the basics. 
 
Put your cursor at the beginning of your document, then choose the “Insert” pull-down 
menu: 

 
 
You will get another window that asks you to make some formatting decisions.  The 
default is usually bottom right-hand numbers. 
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If you click on OK, you’ve done all you need to do for the moment.  If you want to see 
what your options are, click on “Format” (we won’t pursue this at this point, but you are 
free to explore on your own). 
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Footnotes 
 

Word will automatically create nicely formatted footnotes (or endnotes) for you.  This 
DOES NOT mean that it magically inserts all the necessary information, but rather that it 
places the note in an appropriate place on the page, and moves the note if the reference in 
the main text moves. 
 
I know, you’re thinking that this is no big deal.  But it is!  Before such nifty software was 
created, footnotes would be inserted at the bottom of the page (using a typewriter—
remember what those are?) and an author would have to know exactly how long his/her 
footnote would be before beginning to type it, so as to leave enough room for the whole 
thing while preserving the margins.  But I digress… 
 
Put your cursor where you want the note to be and then click on the “Insert” pull-down 
menu and choose “Reference” then “Footnote” 
 

 
 
Choose this, and you’ll get a new window that asks you questions about format.  Most 
defaults should be set fine for you—don’t worry about fooling around with them for the 
moment.  Your screen should look like this: 
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Click on “insert” and you’ll return to your document and automatically your cursor will 
move to the bottom of your screen, waiting for you to type your footnote.  Do so, then 
use the mouse to move your cursor back to the main text (by clicking anywhere in said 
main text). 
 
Once you’ve typed your footnote, it will look something like this: 
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In this case, you’ll want to italicize the title of the work to which you refer.  You could 
underline it instead, but italicizing looks nicer (underlining was common when we used 
typewriters, and there was no way to change font).   See the next page for details… 
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Italicizing 
 

It’s easy to italicize—and it is done essentially the same way you change the font size 
(see beginning section of this handout).  Simply highlight what you want to change 
(using the mouse is easiest here) and then go to the toolbar and click on the italic capital 
“I,” located between the bold “B” and the underlined “U.” 
 

 
 
Voila, you have italicized.  And, now you know how to make something bold type or 
underlined, too. 
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Running Spell Check 
 

You’ve finished your paper and you’re happy.  But it’s three in the morning and you’ve 
never been the most accurate typist in the world.  Trust me, this will not matter to your 
instructor: he or she will find it irritating to receive a paper if you haven’t bothered to 
check the spelling.  Word will automatically check your spelling for you, underlining 
everything that’s wrong with a red, squiggly line.  A green squiggly line means that the 
grammar may be questionable.  (These squiggly lines will not show up when you print 
the document.)  Note on my examples that “blah” is underlined, because Word does not 
recognize it as a properly spelled word. 
 
Word will also often fix problems for you as you type, which is handy.  However, to be 
safe, it is best to double check.  Once you have finished typing, either go through and 
make sure EVERY red squiggly line is fixed OR you can check using one of the Word 
tools.   
 
Click on the “Tools” pull-down menu and choose “Spelling and Grammar” 
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Word will let you add vocabulary to your database, which is handy when the name of 
some Japanese, Chinese, or Korean person is initially marked as misspelled (because 
Word doesn’t recognize it).  Follow the Spell-check window instructions—they are self-
explanatory. 
 
OK, now you should be close to finished with your assignment.  Here’s what’s left: 
 
You need to SAVE your document, or all your work is for naught.  Click on the “File” 
pull-down menu and choose “Save” 
 

 
 
Alternatively, you could click on the toolbar icon that looks like a floppy disk.  Either one 
is fine. 
 
The window you get asks you what to call the file, where to put it, and what format you 
want.  Each one of these is important!  So, let’s look at one at a time: 
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Naming your File 
 

By default, Word will name your file whatever the first thing in it is.  For example, the 
sample file here is called “The Development of the Japanese Written Language.doc” 
 

 
 
This is often fine, but you can change it if you want.  The .doc extension indicates that it 
is a Word file, and is best not changed.  But, you can give the file just about any title you 
want.  In the bad old days, the file title could only be eight characters long, and those 
characters were limited.  (We had to walk miles to school in the snow, then, too, but I 
digress again.) 
 
Choose a title that is easy for you to recognize, and has enough distinguishing features 
that you won’t accidentally write over it later (i.e., don’t call it “term paper” call it “Term 
paper for EAS205 Spring 2003” or something like that). 
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“Save In, ” or “Where did I put that file?” 
 

Choose your drive carefully.  One of the most common mistakes is saving a file in a drive 
you can’t remember, or didn’t notice, or both.  In the main window you’ll see the 
subdirectory (in this case “205”—see above), but not the whole tree unless you click on 
the arrow to the right of the window: 
 

 
 

So, if I click on “Save” now, my file will be on the “fessler” drive of the mainframe, in a 
subdirectory I created called “data,” and then in a subdirectory of THAT called “205.”  
These directory were all set up by me—they were not automatic!  If you are working on a 
machine in a computing center, you’ll probably have to save to the A: drive—don’t 
forget to bring a floppy! 
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“Save as type” or Saving in a different format 
 

Sometimes you’ll be sending a file to someone who doesn’t have the same software as 
you do.  In this case, you need to save the file in a different format.  This is also done in 
the “Save” window.  By default, your file will be saved as a Word (.doc) document.  If 
you want to change this, you need to click on the arrow to the right of the “save as type” 
window and choose your format: 
 

 
 
You’ll have many choices.  The one you need for this class is “Rich Text Format” or .rtf 
format.  This is a generic format that preserves much of your formatting and can be 
opened by most word-processing programs. 
 
NOTE: Most assignments for this class DO NOT need to be submitted as .rtf files (Word 
format is fine).  HOWEVER, for the purposes of showing that you CAN “Save As” 
you’ll need to do this at least once or twice. 
 
Choose “Rich Text Format (*.rtf) and you’ll find that Word will save the document with 
the same title but with a difference extention—in this case, .rtf instead of .doc.  This is 
convenient, because it means your .doc file is not overwritten (and consequently lost). 
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